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1 PLATFORM SUPPORT

ETI Solution® 5.0.2 is now available to all ETI Solution customers. Evolutionary Technologies
International® (ETI™) recommends that existing customers upgrade to this new release as soon as
possible to facilitate development and implementation of conversions.

1.1 Supported Platforms
For a list of supported platforms for ETI Solution 5.0 please refer to your ETI Solution Administration
Guide, Appendix E.

1.2 Required Operating System Patches
At the time these release notes were written, operating system patches were required for all supported
platforms. For the most current list of required operating system patches, select the Hardware Specs
option on the ETI AnswerLink website:

http://www.eti.com/answerlink

Then select the Required Operating System Patches option under the ETI Solution section.

1.3 Obsolete Hardware, Operating Systems, and Releases
ETI Solution 5.0 no longer supports Solaris 2.6.

2 PRODUCT INTER-OPERABILITY

2.1 ETI Data System Libraries
ETI Solution 5.0 can be used with any supported ETI Data System Library (DSL) or ETI Starter Kit. The
following DSL components are required for use with ETI Solution:

• The DSL for Shared Objects release 4.2.2 (or later) is required.

• The DSL for Tcl Functions 4.2.1 (or later) is required.

• DSL upgrade kits for ETI Solution Version 5

• CETutorial Release 6 or later is required.

2.2 ETI•Impact Analyst 5.0
ETI• Impact Analyst 5.0 ships with the ETI Solution 5.0 release and will be automatically installed on the
MetaStore™ Server and Integration Architect Client systems.



Page 5

3 INSTALLATION

To install ETI Solution, follow the installation instructions included in the document titled “Quick Install
Guide.html” located on your ETI Solution for Windows distribution CD. You must use Internet Explorer
Browser to run the Quick Install Guide.

3.1 Using NFS Maestro with Integration Clients
If you are using NFS Maestro to provide file system access for your ETI Solution Integration Clients,
then special setup may be required to ensure that the Integration Client is able to follow symbolic links
correctly. Each file system traversed by the symbolic link must be shared (that is, exported) on the
MetaStore Server. Additionally, the Integration Client must map a drive to each exported file system.

3.2 Installation on Windows
The Browse button for the "Open MetaStore" dialog may not work correctly for Integration Specialist
Clients installed on Windows NT or Windows 98. The dialog may return an empty list of directories. The
directory browser requires the Microsoft Windows Management Instrumentation (WMI) Core 1.5 to be
installed in order to work correctly. This software can be downloaded from the following location:

http://msdn.microsoft.com/downloads/default.asp?url=/downloads/sample.asp?url=/MSDN-
FILES/027/001/576/msdncompositedoc.xml

3.3 Integration Specialist Client Setup for Using the Executive (Optional)
By default the Integration Specialist Client is not configured to run the Executive. This section describes
the optional Executive configuration options and steps. In a future release, the following options will be
integrated into the installation program.

There are two options available for configuring the Integration Specialist Client to use the Executive:

• Option 1 — Setup the Integration Specialist Client to use the Executive program files installed
on the MetaStore Server

• Option 2 — Install a local copy of the Executive program files on each Integration Specialist
Client

ETI recommends that most Integration Specialist Clients use Option 1. This configuration is
recommended when want to centralize the software to facilitate maintenance, and/or you want to
minimize the amount of disk space required to install the Integration Specialist Client. For slightly better
performance, you can install the software onto each client system using Option 2. This configuration may
be preferable when an Integration Specialist Client is accessing the Application Server and MetaStore
Server via a low speed connection such as dial-up or WAN.

Follow the instructions listed in the section below for either Option 1 or Option 2.

3.3.1 Option 1 — Executive Configuration Using Executive Files on MetaStore Server

The Executive uses information stored in the Integration Specialist Client configuration file. To enable
the Executive, you must manually update the Integration Specialist Client configuration file. The
following example is based on the default share names and installation directories. If you have installed
into alternative locations or used alternative share names, you must modify your configuration file
appropriately.
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The Integration Specialist Client configuration file, ETISolution.exe.config, is located by default in the
C:\Program Files\ETI\Solution\rel50\Client directory. By default the file looks similar to the following:

<configuration>
<appSettings>

<add key="ExtractHost"
value="http://hathor/ETIService50/ETIService.asmx" />

</appSettings>
</configuration>

where hathor is the name of the Application Server. You will see the name of your Application Server
instead.

In the application settings section (appSettings), you will need to add another tag to identify the location
where the Executive source files are installed. This entry should be added after the <appSettings> section
of the configuration file.

Since your Integration Specialist Client is using the Executive source installed on the MetaStore Server,
you would add an entry similar to the following marked in bold to your configuration file:

<configuration>
<appSettings>

<add key="ExtractHost"
value="http://hathor/ETIService50/ETIService.asmx" />
<add key="Executive" value="g:\" />

</appSettings>
</configuration>

where g: is the drive letter mapped to the eti-extract share on the Windows MetaStore Server and
hathor is the name of the Application Server.

3.3.2 Option 2 — Executive Configuration Using Executive Files Installed on Integration
Specialist Client

Using Windows Explorer, locate the file named executive.exe on the 5.0.2 installation CD in the data
directory. Double-click the file executive.exe to run the self-extracting executable. A dialog is displayed
with the default installation directory set to C:\Program Files\ETI\Solution\rel50.

This installation directory is correct if you accepted the default installation location when you installed
the software. If you installed to a different location, then the pathname for extracting the files must be
changed to reflect your installation location.

The Integration Specialist Client configuration file, ETISolution.exe.config, is located by default in the
C:\Program Files\ETI\Solution\rel50\Client directory. By default the file looks similar to the following:

<configuration>
<appSettings>

<add key="ExtractHost"
value="http://hathor/ETIService50/ETIService.asmx" />

</appSettings>
</configuration>

where hathor is the name of the Application Server. You will see the name of your Application Server
instead.
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In the application settings section (appSettings), you will need to add another tag to identify the location
where the Executive source files are installed. This entry should be added after the <appSettings> section
of the configuration file. Since your Integration Specialist Client is using the Executive source installed
on your local Integration Specialist Client machine, you would add an entry similar to the following
marked in bold to your configuration file:

<configuration>
<appSettings>

<add key="ExtractHost"
value="http://hathor/ETIService50/ETIService.asmx" />
<add key="Executive" value="C:\Progra~1\ETI\Solution\rel50\Executive" />

</appSettings>
</configuration>

Note The pathname value for the added entry cannot be specified using spaces (for example
C:\Program Files\ if you used the default install location), but must be specified instead using the 8.3
DOS equivalent, namely C:\Progra~1\, as shown in the example above. If you have changed the
installation location from the default, you can find the 8.3 DOS equivalent pathname for your directory
by entering the following command in an ETI Command Window and noting the name displayed for the
installation directory:

dir /x

3.4 Requesting Patches, Upgrade Kits and IM Packages
Available product patches, DSL upgrade packages and IM packages are automatically shipped
with your DSL distribution CD.

To download or get a listing of currently available patches, upgrades, or IM packages, select the
Software Downloads option on the AnswerLink site:

http://www.eti.com/answerlink

To request shipment of patches, upgrades or IM Packages on CD or via email, you can contact
the AnswerLine or use the product order form online: http://www.eti.com/answerlink/request

4 ETI Solution Documentation

4.1 ETI Solution and ETI••••EXTRACT®
ETI is in the process of changing the product name from ETI•EXTRACT to ETI Solution. Some of the
documentation has not been updated to reflect the new name.
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4.2 Addendum for the ETI Solution Documentation
ETI Solution 5.0 ships with an addendum to the ETI Solution documentation. This file is named
solution_addendum_50a.pdf and is located in the MetaStore Server doc directory with all the other
documentation files. This addendum has information of interest to the Integration Architect and ETI
Administrator.

The following topics are covered:

• Setup and Use of the Executive

• Administration

• Template Syntax Checker

• Template Functions Override

• Synchronize Conversions: Command line utility for resynchronizing your conversions

4.3 Adobe Acrobat Reader
Adobe Acrobat Reader is not shipped with ETI Solution. If you do not have the latest version of Adobe
Acrobat Reader, you can download it from the Adobe website, http://www.adobe.com/. Locate the link
for downloading Acrobat Reader on the Adobe website. (At the time of publication of this document, a
“Get Acrobat Reader” icon is located on the Adobe home page.) Select the version for your platform,
and include the option for searching PDF files.

5 DSL Upgrade Packages Required for ETI Solution

For most DSLs, a minor change to the retrieve schema scripts is required in order to run the retrieve
schema process from the Integration Client. The required changes are provided as a DSL upgrade
package. Upgrade packages are available for all currently supported DSLs. In general, DA DSLs release
4.2.1 or later do not require upgrade packages, as all required changes have been incorporated into the
released product.

5.1 Installing and Loading DSL Upgrade Packages
The following instructions and information is provided for installing and loading DSL Upgrade
packages:

• Install the DSL upgrade package into the DSL-Install directory on the MetaStore Server

• Load the DSL upgrade package into each ETI Solution 5.0 MetaStore (new or migrated). You
load upgrade packages like a DSL or patch from the DSLs tab of the ETI Administration utility.

• The DSL load program will attempt to automatically identify any patches (DA 4.2.0 or later) or
upgrade kits which need to be applied to your MetaStore.

• It is recommended that you load DSL patches and upgrade kits prior to loading Consulting
Packages and IM packages. DSL patches and the upgrade packages can be loaded in any order.
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• When loading DSLs into a MetaStore, the DSL load program automatically detects available
patches and upgrade packages for any DSL. The load program will prompt you to load any
available patches and upgrade packages. ETI recommends that you autoload patches and
upgrades for any DSL identified.

• Upgrade packages are release specific and therefore the DSL load program will only allow you to
load the packages that are associated with the specific DSL releases loaded in the MetaStore.

• Any changes provided by the upgrade packages will automatically be supplied with the next
release of the associated DSL.

5.2 Information for Customers Migrating from ETI••••EXTRACT
DSL upgrade packages are fully backward compatible and therefore they can be loaded into any
MetaStore created under any ETI•EXTRACT release. However, the upgrade package is only required
for ETI Solution 5.0.

The DSL load program may attempt to autoload upgrade packages into existing MetaStores. Although
upgrade packages are not required for ETI•EXTRACT 4.x MetaStores, ETI recommends that you
autoload patches and upgrades for any DSL identified.

6 Updates

6.1 Updates for Release 5.0.2

6.1.1 Licensing

Use of the DEMO license file is supported with the 5.0.2 release for a Standalone Configuration.

6.1.2 Application Toolbar and Menus

The Show Files button has been added to the application toolbar. This button can be used to show files
for a Conversion open in the Work Area or a selected object in the Browser. This option also works for a
Schema open in the work area or a workset selected in the browser.

An Edit->Deselect All menu item has been added to facilitate deselecting all objects in the Work Area.

• A View->Refresh menu item has been added to facilitate updates to the Browser Area.

• The File->Open Metastore option now gives you an option to open the MetaStore in the same
window you currently have open by making sure the option Open in New Window is not
selected. If you have a MetaStore already open, all work areas will be closed (you will be
prompted to save your changes) and the MetaStore will be closed prior to opening the new
MetaStore.
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6.1.3 Browser

• Ability to import objects from the Integration Specialist client. The Import command is located
on the Tools menu.

• Improved refresh of the workset and object display for new/modified objects

o In prior releases, the Browser did not always update the display correctly for
new/modified objects

• Show Info dialog now displays information on the last person to modify an object.

6.1.4 Conversion Work Area

• Ability to replay business rules for selected components or the entire conversion. Business Rule
indicators in the Table and Detail Areas are automatically updated to identify incomplete
Business Rules and autoreplayed Business Rules. A log file is created each time you replay and
contains the complete details.

• Joins can be displayed in the Detail Area. This allows the user to view or change the properties
that are set by the merge wizard. This also allows the user to add site specific properties for the
join.

• A new command Conversion->Conversion Details has been added for displaying the
Conversion level information in the Detail Area. This will display information about codeblocks
that are attached to the Conversion, the Conversion annotation and properties set on the
Conversion object itself. Conversion information is automatically displayed in the detail area
when nothing is selected.

• The Conversion Properties and Object Properties commands have been combined into a
single command Conversion->Properties. This command will display the properties for the
selected object. If no object is selected, then the properties set on the Conversion object are
displayed.

• The right click menu on the Conversion tab provides common operations for a Conversion such
as Show Files, Conversion Details and Properties set on the Conversion object.

• Edit/copy/paste virtual parts.

• File->Save As no longer creates read-only objects.

6.1.5 Schema Work Area

• Ability to open any schema with the Integration Specialist client as the default behavior.

• The Files->New option for schemas defaults to invoking retrieve schema.

• Ability to set property values.

6.1.6 Retrieve Schema

• It is no longer necessary to copy Host and Installation objects into the local workset prior to
retrieving a schema. The client can now locate the available objects in the workset hierarchy.
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6.1.7 Executive and Conversion Compiler

• Ability to run the Executive from the Integration Specialist Client is supported with the 5.0.2
release, however some manual steps are required for this support. See section 3.3 “Integration
Specialist Client Setup for Using the Executive (Optional)” for detailed instructions.

• Executive window, Conversion Compiler output window, and other text windows had text size
limitations. These were changed to allow unlimited display of text information.

6.1.8 Preferences

• Schema

o Allow Integration Architects to select whether opening a schema object will be done
using the new or the old schema editor.

o Allow user to specify the location where schema input files exist. This allows the
user to have a shared directory for multiple MetaStores. By default, the client
assumes that all input files are located in the MetaStore’s DAS directory.

o Allow user to select if the schema object should be automatically opened into the
work area following retrieve schema. The default is “yes”.

6.2 Updates for Release 5.0.1

6.2.1 Preferences

Additional preferences were incorporated into the 5.0.1 release:

• Conversion Work Area

o New preferences for rollover text

o Ability to disable warning indicator for auto-replayed Business Rules

o Ability to disable autoexpand on new part mappings

• Browser

o Ability to disable rollover text for objects and worksets

o Options for displaying fully-qualified object names, version number, and newer
version indicator in the Browser area

6.2.2 Browser

• Ability to delete objects in the Browser

• Info Dialog is resizable

6.2.3 Conversion Work Area

• Ability to delete joins from the graph view using the right click menu

• Properties dialog did not allow input of non-alphanumeric characters (for example the
underscore ‘_’)
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7 Known Limitations
The following is a list of known limitations with the ETI Solution 5.0.2 release.

7.1 Preferences
Most of the general preferences will not take effect until the MetaStore is reopened. This will be fixed in
a future release.

7.2 Browser
• The Browser Area for the Integration Specialist Client provides most operations used

by both the Integration Architect and Integration Specialist. The following operations
are limited to the Integration Architect Client:
o Running registered tools.
o Patch Overrides/Overrides patch
o Creating the SQL Retrieve Schema script for relational databases.

• Checkin/checkout/uncheckout
o Only a single object can be selected at this time for the checkin, checkout, and

uncheckout commands.

7.3 Access Control within a MetaStore
• The Integration Specialist Client does not display access control information in the

Browser Area or Object Info Dialog.
• The Integration Specialist Client does not currently enforce access control settings for

viewing and modifying objects
• The Preferences dialog does not reflect access control settings in the personalized workset

view or personalized object views.

7.4 Merge Wizard & Joins

7.4.1 Sequence Numbers
• The user interface has been updated to allow you to specify sequence numbers for

relational intra-database joins. However, this information is not yet utilized in generating
code. An upcoming release will use these sequence numbers to control the order in which
ETI Solution performs the joins for merging the data.

• Sequence numbers are not applied to navigational joins (joins that represent parent-child
relationships). If you set a sequence number on this type of join, it will be ignored by the
Generator.

• If the same join is applied to the merge logic for two different target units, then only a
single sequence number can be set. You must ensure that the sequence number is set
appropriately for the processing of both targets. Alternatively, you can use virtual units to
achieve greater control over join processing.
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7.5 CodeBlock Work Area

7.5.1 Paste from Word documents

If you copy and paste text from a Word document into the codeblock editor, you will corrupt the
codeblock.

7.6 Schema Work Area
Currently, the schema is not fully implemented for the Integration Specialist Client. You can open any
schema object and set properties. You can also set date formats for COBOL/FS schemas. However,
creating joins, ghost tables, and other advanced schema operations should be performed from the
Integration Architect Client.

7.6.1 COBOL/FS Date Formatting

It is recommended that you select either the Integration Architect or Integration Specialist Client for
retrieving the COBOL/FS schemas. If you use the Integration Specialist Client for setting date formats
and then re-retrieve or merge the schema from the Integration Architect client, you may experience a loss
of date formats or inconsistent results.

7.7 Retrieve Schema
The retrieve schema process for the DSL for SAP R/3 and the Starter Kit for COBOL/IDMS can only be
run from the Integration Architect Client. This will be addressed in a future release.

8 INFORMATION FOR USERS UPGRADING FROM 5.0.0 or
5.0.1 RELEASES

8.1 Migrating Your Preferences File (Optional)
With the 5.0.2 release we have moved the location where the user specific preferences are stored. If you
are upgrading from a prior 5.0 release, you will lose your user specific preferences. To migrate your
preference file from the 5.0 release to the 5.0.2 release, copy the Preferences.xml file located in:

C:\Documents and Settings\user\Application Data\Evolutionary Technologies International, Inc\ETI
Solution(tm) Version 5

to the directory:

C:\Documents and Settings\user\Application Data\Evolutionary Technologies International, Inc\ETI
Solution Version 5
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8.2 Uninstalling Windows Components
There have been changes to all the components which ship with the ETI Solution 5.0.2 release.
Therefore, if you are upgrading from a prior release of ETI Solution you must uninstall all the Windows
components prior to installing 5.0.2. Detailed uninstall instructions are provided in the Quick Install
Guide located on your Windows installation CD.

8.3 Confirming Deletion of the Application Server Directory
After uninstalling the Application Server software, make sure that the
C:\Program Files\ETI\Solution\rel50\Application Server directory has been removed from your system,

where C:\Program Files indicates the default installation location for the Application Server software
on your Application Server. If you did not use the default location, then the pathname shown above must
be changed to reflect your alternate installation location.

If the directory was not automatically removed, then you must manually delete it prior to installing the
5.0.2 software.

If this directory is not removed, then you may experience problems connecting to the Application Server
after upgrading to 5.0.2.

9 INFORMATION FOR USERS UPGRADING FROM 4.x
RELEASES

9.1 ETI••••EXTRACT 4.x Releases
ETI Solution can be installed on the same system that has ETI•EXTRACT installed.

9.2 MetaStore Compatibility
If you are upgrading to ETI Solution 5.0, you must migrate your MetaStore. Please see the “Moving and
Migrating MetaStores” chapter in the ETI Solution Administration Guide.

9.3 Generator (Conversion Compiler)
The Generator is backwards compatible with optimization levels 0-4. It is not necessary to regenerate or
revalidate any existing conversions when upgrading to release 5.0.

9.4 Export File Format
The export file format for Conversion objects has been modified with the ETI Solution 5.0 release. This
was done in support of new features and functions in the 5.0 release. Therefore, it is not possible to
export conversions developed with ETI Solution 5.0 and import them into an older release of
ETI•EXTRACT automatically.
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9.5 Licensing for DSLs, DSL add-on products, and Custom DSLs
With the ETI•EXTRACT 4.2 release, all DSLs, DSL add-on products, and custom DSLs are licensed.
The licensing is controlled by a FEATURE line in the FLEXlm license file. Customers upgrading to ETI
Solution 5.0 from releases 4.1 and prior will need to ensure that they have an updated license file which
supports DSL licensing. The updated license file is backward compatible with prior ETI releases.
Therefore, the license file can be installed for use with both ETI Solution and any prior release of
ETI•EXTRACT.

9.6 ETI•Impact Analyst
ETI• Impact Analyst ships with the ETI Solution 5.0 release and will be automatically installed on the
MetaStore Server and Integration Architect Client systems. If your site uses the ETI•Impact Analyst
product, you must upgrade to ETI•Impact Analyst release 5.0 for use with the ETI Solution 5.0 release.
The MetaStore components for ETI• Impact Analyst have been re-released. The MetaStore component,
impact_analyst.IANALYST_5_0_0_2, should be loaded via the DSL load process after any MetaStores
have been migrated to ETI Solution 5.0.

9.7 Syntax Changes for Custom Tcl Functions
ETI Solution release 5.0 for UNIX platforms ships with version 8.0 of Tcl. This release of Tcl contains
bug fixes and enhancements. See the following web page for differences:

http://www.scriptics.com/doc/compiler.html

The 8.0 version of Tcl contains a more restrictive syntax checker. Therefore, customers migrating from
releases prior to ETI•EXTRACT release 4.2 on UNIX platforms must:

• Upgrade their Tcl functions DSL to release 4.2.1 or later.

• Verify that custom Tcl functions, created by the customer, are compliant with the required Tcl
syntax.


